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1 Introduction

Throughout the 1970s and 1980s, Machine Transldhbr) research focused on the
development of so-called “second generation” systemiich aimed to translate text
by a process of rule-driven linguistic processingyally in three stages: syntactic-
semantic analysis of the source text, bilinguatdfar at a more or less abstract level
of representation, and target-text generation fimtactic representation. At the
same time, from a practical point of view, thereswiauch discussion on how systems
built with this architecture could be used to detiva reasonable standard of
translation usable by real users. Most popular waas of restricting the input (the
sublanguage and controlled language approache#)yalving the user in pre- and
post-editing. Interactive MT, where the user ane tdomputer would cooperate in
resolving ambiguities and making choices, was alsompioned.

In the early 1990s, with these ideas fairly wellabished, and perhaps even
growing stale, research in MT was hit by an applremew paradigm in which in
particular the reliance on linguistic rule systewss to be (at least partially) replaced
with the use of a corpus of already-translated giesnwhich would serve as models
to the MT system on which to base its new trar@hatiThis approach came to be
known as Example-Based MT (EBMT) which had in fécdt been proposed ten
years earlier, in 1981. We will look in a little neodetail at this development below.

At about the same time, a new tool for translatwes being mentioned by
developers. Like EBMT, it used a corpus of alretrdypslated examples to serve as
models for the new translation, but crucially, assthe human users, not the computer
itself, who should determine exactly how to use éxamples in producing a new
transla}ion. This tool is of course now widely knoas a Translation Memory System
(TMS).

There are many commentators who regard EBMT and sTB&Sessentially the
same thing, and indeed certain developments inlmik brought them closer to each
other. The present author has long maintainedttieaé is a crucial difference, which
will be elaborated in the next sections. Howevéere are similarities, and in
particular proposals to make TMSs better invariabbke them look more and more
like EBMT systems. This, principally, is the sulije€this paper.

! We will throughout distinguish the system from fisncipal component, the database of stored
translations, i.e. the “memory”. For this reason wi#l refer to the systems as TMSs, and to the
database itself as a TM.



2 Intertwined history of TMSs and EBMT

At a risk of repeating points that are familiaréaders of this journal, we wish in this
section to describe some key moments in the deredap of the concept of TM(S)s.
The original idea for a TM is usually attributedNtartin Kay’s well-known “Proper
Place” paper (1980), although the details are biited at obliquely:

[T]he translator might start by issuing a commaadsing the system to display anything in the
store that might be relevant to [the text to bedtated] .... Before going on, he can examine
past and future fragments of text that containlginmaterial. (Kay, 1980:19)

Interestingly, Kay was pessimistic about any of hldeas for what he called a
“Translator's Amanuensis” ever actually being immpénted. But Kay’'s observations
are actually predated by the suggestion by PetthreAr (1978) that translators can
benefit from on-line access to similar, alreadystated documents, and in a follow-
up article, Arthern’s proposals quite clearly désewhat we now call TM(S)s:

It must in fact be possible to produce a prograrfsitg which would enable the word processor
to ‘remember’ whether any part of a new text typ&d it had already been translated, and to
fetch this part, together with the translation whiad already been translated, ....

Any new text would be typed into a word processstation, and as it was being typed, the
system would check this text against the earligtstastored in its memory, together with its

translation into all the other official language$ the European Community]. ... One advantage
over machine translation proper would be that ak tpassages so retrieved would be
grammatically correct. In effect, we should be @pieg an electronic ‘cut and stick’ process

which would, according to my calculations, savelesst 15 per cent of the time which

translators now employ in effectively producingskations. (Arthern, 1981:318).

Alan Melby (1995:225f) suggests that the idea miggwe originated with his
group at Brigham Young University (BYU) in the 1$/0Vhat is certain is that the
idea was incorporated, in a very limited way, frabout 1981 iraLPs, one of the first
commercially available MT systems, developed byspenel from BYU. This tool
was called “Repetitions Processing”, and was lichitefinding exact matchesodulo
alphanumeric stringSThe much more inventive name of “translation meyhooes
not seem to have come into use until much fater.

The first TMSs that were actually implemented, afram the largely inflexible
ALPS tool, appear to have been Sumita and TsutsumBSB8)LETOC (“Easy TO
consult”), and Sadler and Vendelman’s (1990) Bilialgkinowledge Bank, predating
work on corpus alignment which, according to Hutsh{1998) was the prerequisite
for effective implementations of the TM idea. Ald¢ugler et al. (1991) report on
work by Keck (1989) based on statistical methodhécontext of agspPRriTresearch
project. It is difficult to pinpoint when TMs entat the consciousness of translation
studies researchers and translators in generaln Btarris, introducing the notion of a
“bi-text” in a translators’ magazine, proposes stinmg like a TM without using that

2 Early proposals for a TM, and other aspects oidke of a Translator's Workstation are descritied i
Hutchins (1998).

3 Curiously, this most innovative feature is bareigntioned in descriptions of the ALPS system, two
exceptions being Sibley (1988:96,100) and Weav@8§1121f) who mention the facility almost as an
afterthought.

* Extensive enquiries have so far failed to prodacmtisfactory identification of the first use bfst
term. Hutchins (1998:303) suggests that the Tradagpany were the first to use the term.



name (Harris, 1988:9):a database of paired translations, searchablerelily
individual word, or by “a whole translation unitf) the latter case the search being
allowed to retrieve similar rather than identicaits. Cave (1988) responded to that
article with an announcement that Logos were margejust such a tool. In an
unsigned 1991 article the magazlrenguage Internationaleported that “text banks”
had now made their appearance:

The first of these would seem to have been IBM peam Language Service's Translation
Support Facility (TSF), which, ..., incorporatedrepeated sentence identification facility
(Anon, 1991:5; emphasis added).

The article goes on to explain the notion of “furatch” (sic) in the case where exact
matches are not found.

The proceedings of Aslib’s indicative annual coafere serie§ranslating and
the Computercontain no mention at all of TMs until 1992, whtee separate
articles (Freibott, 1992; Le-Hong et al., 1992; @wam, 1992) mention them, in one
case (Le-Hong et al.) without feeling the need xpl&n the term. Brace (1992)
reported development of a TM tool by Trados, ad a®theEsPrITproject mentioned
above, and projects at IBM’s European Language i&sv(Denmark) and the
Official Languages and Translation sector of thend&kan Department of the
Secretary of State in Ottawa.

The idea for EBMT has a similar chronology, witlead surfacing in the early
1980s (the paper presented by Makoto Nagao at & d@&erence was not published
until three years later — Nagao, 1984), but thenndaivelopments being reported from
about 1990 onwardsThe essence of EBMT, called “machine translatipexample-
guided inference, or machine translation by thelagyaprinciple” by Nagao, is
succinctly captured by his much quoted statement:

Man does not translate a simple sentence by doéep dinguistic analysis, rather, Man does
translation, first, by properly decomposing an inpentence into certain fragmental phrases ...,
then by translating these phrases into other laggyparases, and finally by properly composing
these fragmental translations into one long seetehbe translation of each fragmental phrase
will be done by the analogy translation principléhwproper examples as its reference. (Nagao,
1984:178f)

Nagao correctly identified the three main compos@ftEBMT: matching fragments
against a database of real examples, identifying ¢tbrresponding translation
fragments, and then recombining these to givealget text. Clearly EBMT involves
two important and difficult steps beyond the matghiask which it shares with TMS.

The idea of EBMT really took off in the early 19904th an increasing number
of papers at conferences reporting on this appro@ineers were mainly in Japan,
including Sato and Nagao (1990) and Sumita et18®9(@). Mention should also be
made of the work of the DLT group in Utrecht, oftgmored in discussions of
EBMT, but dating from about the same time as (amdbgbly without knowledge of)
Nagao’s work. The matching technique suggested dyal involves measuring the
semantic proximity of the words, using a thesaufusimilar idea is found in DLT’s
“Linguistic Knowledge Bank” of example phrases déssd in Pappegaaij et al.

® In the next paragraph, he describes it as pragittinmemory-perfect exploitation of the translasor’
own previous experience”.

® A thorough review of the literature on EBMT iseattpted in Somers (1999).



(1986a,b) and Schubert (1986:137f). Sadler's (19&l)ngual Knowledge Bank”
clearly lies within the EBMT paradigm.

During this early period, individual researcherstie field used alternative
names, perhaps wanting to bring out some key éifiee that distinguished their own
approach: “case-based” (Collins and Cunninghamg)l 9%nalogy-based” (Nagao,
1984), and “experience-guided” (Zhao and Tsujii99Pare all terms that have been
used. The first of these recalls approaches to Madtearning known as “case-based
reasoning” (Riesbeck and Schank, 1989), and othleted modeld.Another term
found is “memory-based translation” (Sato and Nad®®0; Kitano, 1993), the use
of which probably did most to suggest affinitiesviieen EBMT and TMSs.

3 What EBMT and TMSs could have in common

EBMT and TMSs have in common the use of a databhpeevious translations, the
“‘memory” or “example-base”, and the essential fs&tp, given a piece of text to
translate, of finding in the example database #st match(es) for that text. Once the
match has been found, the two techniques beginvierge. However, it would be
misleading to assume that all they have in comnsathe task of matching, or even
that the approaches to matching in the two cam@sarticularly similar. Use of a
database implies issues of database design, cpatahtmaintenance. These will be
the focus of the next sections.

3.1 How are examples found?

In TMSs, the TM database itself can be constructedne of three ways. The
simplest method, though the most time-consuming, ooalled “interactive
translation” by Bowker (2002:108f) is to build a Tikbm scratch, that is, to store in
the memory each sentence as it is translated. @éndemethod, referred to by Bowker
(2002:109f) as “post-translation alignment”, andcmineralded by manufacturers, is
to extract a TM from an already translated texabgning the source and target texts.
This can be a more or less irksome task (cf. Maalipn2001), and there is a
considerable literature describing various alignimerethods involving differing
amounts of (linguistic) sophistication (see Mannangd Schitze, 1999:466-486 or
Wu, 2000a). O’Brien concludes:

A translation memory is always more accurate wheras been created by interactive
translation as opposed to automatic alignmentaighment can produce a reasonably accurate
translation memory which can be used as a starfQiBrien, 1998:119)

Finally, TMs that have already been created cammiperted, and the establishment of
agreed interchange formats between manufacturereugely facilitated this (notably
the Translation Memory eXchange (TMX) format deypeld by LISA (Localisation
Industry Standards Association, cf. Melby, 1998)@2&nd Topping, 2000).

The size of the TM is an obvious question. The Tigrature says little more
than “the bigger the better”, subject to processiimgtations, though Bowker
(2002:108) warns that “size should not come at é¢lxpense of organization”,
suggesting that separate TMs for different sulfjetds or clients may help to reduce
false hits caused by homonymy. She adds:

" The relationship between EBMT and Case-Based niagds discussed in Somers and Collins (in
press).



Keep in mind that a larger TM will result in a greanumber of matches .... Therefore, while it

may seem logical at first glance to build a siniglgge TM ..., this may turn out to be a false

economy.... Moreover, there is a greater likelihobdetrieving “noise” (e.g., matches that are

not helpful, matches containing homonyms) and ithiestator may waste a considerable amount
of time analyzing, eliminating, or editing theseopmatches.ifem)

For Heyn (1998), a “big” TM will have between 10000and 1 million units, thanks
to recent technology advances.

In recent sparsely-coded-matrix based systemsjmeabctive work on ‘big’ master translation
memories is possible. Big translation memoriestgpally in the order of 100,000 translation
units, although memories in the range of 500,00D,800,000 translation units are envisaged by
the end of 1997. According to current researchregts, translation memories could be made
up to 40% bigger without any increase in constaness times. (Heyn, 1998:128)

In the EBMT literature, the sizes of the exampledsareported vary over a
huge range, with 0.73m the biggest, and 7 (seudr!smallest reported (cf. Somers,
1999:120). Obviously, the systems with tiny exarfpses are purely experimental,
while the more serious systems will have thousasfdexamples (rather than, say,
hundreds).

User manuals for TMSs suggest revising the datadaesgy so often to clear out
useless examples. By “useless” is presumably m&eott used” rather than, for
example, “misleading” (cf. Heyn, 1998:131f). It éasy to see how a TMS could
incorporate a measure of the former, simply by tiograccess. To measure the latter,
it would also need to “know” what the translatordiging with the proposed match.
The “suitability” of examples is addressed in tlhatext of EBMT systems by various
researchers. Nomiyama (1992) introduces the naifofexceptional examples”, an
idea further developed by Watanabe (1994). Asdaraa be seen, these examples are
exceptional just in the sense that if used they dghe wrong result! Clearly a more
systematic notion is needed. It is well known ttet same phrase can be translated
differently in different circumstances. Ellipsispagphora and stylistic variation can
contribute to this, in which case different examspleay be seen as nonetheless
equivalent in some sense. On the other hand, therlymg meaning of a phrase may
differ depending on the context. Somers et al. (i) illustrate how the simple
phraseOK in a conversation may be translated into Japaaeseakarimashita‘l
understand’iidesu yo'l agree’ orijo desulet’s change the subject’.

There is also an issue of “granularity”: both in Eid EBMT, there is a trade-
off between length and similarity of examples. Toeger the example units, the
lower the chance of an exact match; but the shdtier units, the greater the
probability of “ambiguity” (multiple, conflicting,matches), with a corresponding
decrease in the quality of the proposed translatirenburg et al. (1993:48) call this
“passage boundary friction and incorrect chunkinigie obvious and intuitive “grain
size” for examples, to judge from almost all TMSsdaEBMT systems, is the
sentence, though evidence from translation stu@iBesloff, 1987; McTait et al.,
1999) suggests otherwise: human translators promedsin “naturally-occurring
syntactic units” and “generally there is very @ttprocessing at sentence level”
(McTait et al., 1999). According to Bennett,

... there are good reasons for keeping the U[jitfT@fanslation] (in the sense of translation
atom) in MT as small — and hence as manageablepessible. Adopting a larger UT may be
less efficient, and is not guaranteed to improaagiation quality. (Bennett, 1994:18)

the “translation atom” being the smallest segmbat must be translated as a whole
(ibid., p.13). Schaler et al. (2003) echo this sentimenggesting that “matching



segments at sentence level unnecessarily redtinetpotential and the usefulness of
translation memories” (p. 89), and propose “phrasatching” as the primary
mechanism for TMSs. Simard (2003) studied how vsars make use of a bilingual
concordancer, a tool which closely resembles a TiM8nction, except that users can
look up arbitrary sequences of words. He found thast users look up syntactically
well-formed “chunks”, and implemented a system Hase this principle. In fact,
matching segments rather than whole sentences @edar too many “hits”, so the
system must also have a way of selecting the m&sfulifrom amongst them. An
evaluation of Simard’s implementation suggested itharoposed between 15 and 30
times more “reusable material” than a sentenceebagstem.

Both EBMT and TMSs could probably be improved byaentrating on a more
flexible view of the unit of matching/translaticemd “the exploitation of fragments of
text smaller than sentences” (Cranias et al., 19M): In TMSs, this idea is partly
addressed in that terminology look-up is often saeran integral part of the tool,
although terminology tools are generally implemdrntea lexicon-based rather than a
memory-based manner. We will return to the issudragjments” below. According
to Bowker,

Many TM systems allow the user to define othersinftsegmentation in addition to sentences.
These units can include sentence fragments or @viine paragraphs. (Bowker, 2002:94)

Along the same lines, Esselink states:

A segment is a text element, which is considerethbyapplication as the smallest translatable
unit, defined by periods, semi-colons, and hardrrst These are usually sentences, but can also
be chapter headings or items in a list. ....Traimlamemory tools usually allow the user to
change and customize segmentation rules. (Ess@@ti):362f)

3.2 How are examples stored?

In TMSs, examples are generally stored as plaih, ®metimes with formatting
information. Systems differ as to how they treanfatting (i.e. fonts, capitalization
and so on) even though it is potentially very ukd@r matching (see below).
Austermihl comments that

Some translation memories have a built-in interféogg works with common word-processors
... the format in which the translated text is stbin the translation memory is identical to that
used in the word-processing program. (Austermid022138)

From this we must infer that segments always kkep original format when stored.

A different issue is the way TMS deal with tagswéolays, translation tools are
being used extensively in the software localizatimtustry. For this reason, the new
generation of TMSs such as Trados, Transit and Dé@jaontain a wide range of
filters to convert files from one format to anoth&t the same time, TMSs are
designed to handle a wide variety of formats sushrHaAML, SGML and XML.
Esselinkconfirmed the following in the year 2000:

Most translation memory tools have standard filthms HTML files. HTML files usually
contain very repetitive text, so it is worthwhileing translation memory, because of the
substantial time and cost savings. Furthermoraslkaéing updates of web sites is much easier
and quicker if a translation memory of the previvassion exists.

Examples of translation memory tools that supploet HTML format are Trados Translator’s
Workbench, IBM TranslationManager, STAR Transit, L3D and Atril Déja Vu. (Esselink,
2000:218)



In 2003 new versions of TMSs have spread throughimimarket. These new
versions are well equipped to deal with every kaicapplication for the design of
web pages, presentations, graphics, etc. Thussitréx includes a number of filters
that make it possible to translate files generatgith programs such as Excel,
PowerPoint, QuarkXPress, PageMaker, FrontMakerAaitdCAD, among others. In
the same way, the latest solutions presented imiiwdket by Trados and Déja Vu,
namely, Trados 6.5 and Déja Vu X, incorporate ridtehich allow the user to import
and export files with any kind of format.

Increasingly, TMS developers are recognising tHeevaf incorporating “mark-
up” into their systems, not just formatting butaalénguistic annotations such as
syntactic part-of-speech (POS) tags. In this resg&lanas (1999:8), states that the
Xerox XMS Memory Manager, is a “linguistically bas&ol”, and consequently is
capable of retrieving better matches than chardi@sed systems. We read “this
shows the crucial importance of using linguistidad&r enabling more precise
retrieval of the closest sentence in the databada% system is currently still in the
experimental stage however. Planas and Furuse \19@fhosed a much more
elaborate scheme in which examples are represemted multi-level lattice,
combining typographic, orthographical, lexical, ®atic and other information. A
major drawback of the most successful TMSs availablthe market has to do with
the lack of incorporating linguistic knowledge hetr products.

Obviously, storage and matching methods are ingigaelated: we will return
to the latter in the next section.

In EBMT systems, a wide range of formats have h@eposed for storing the
examples. Given its origins as a variant of ruledsh MT, early EBMT systems
supposed that examples would be stored as aligeedstructures such as the one
illustrated in Figure 1, from Watanabe (1992).

subj obj

e e
S

Figure 1. Representation schema Kanojo wa kami ga naggdlit. ‘she ToPIC hair suBJ
is-long’) - She has long hair

Unfortunately, such a representation involves ssrioverheads in storage space,
analysis at run time, and verification of structyra criticism that also applies to
Planas and Furuse’s proposal, as shown in Figuf@&resulting reliance on parsing
or other knowledge-rich processes is acknowledgetldgisadvantage.



Because these rich representations are widespreadriy EBMT proposals,
they are often thought of as beingecessaryeature of EBMT, though this is quite
incorrect. Later EBMT proposals involve much lesshdious representation schemas,
in particular lightly annotated text in which wordse accompanied by POS tags
and/or the results of “stemming” (i.e. morphologiaaalysis to identify root or stem,
and partially interpret endings). Planas (19991Risirates the idea by considering
sentence (1a) compared to each of (1b-d): alth¢Lghdiffers by only one character,
humans instinctively find (1b) a better match.

(1) a. The white horse is nice.
b. The white horses are nice.
c. The white house is nice.
d. The white houses are nice.

19400, 0. 239.0,040
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Figure 2. Structured representation suggested ‘@lick a color and press ENTER
(from Planas and Furuse, 1999, p. 333).

An important recent trend in EBMT is to store samiexamples in a unified
“generalized” manner. For instance, the two exampig2a,b) could be generalized
as (2c), and stored as such, with obvious repaans$or matching (see next section).

(2) a. John Miller flew to Frankfurt on December 3rd.
b. Dr Howard Johnson flew to Ithaca on 7 April 1997
c. <person-m> flew to <city> on <date> .

An early proposal along these lines is found inuBar and lida’s (1992)
distinction between “literal examples” and “pattexamples”, the latter containing
variables in place of words, with the variablesrebterized by a (list of) typical
filler(s), as in (3

® They also have a third type, called “grammar eXasipwhich consist almost entirely of variables,
rather like the rules in conventional MT.



(3) a. X 0 onegai shimasu. may | speak to the XX=jimukyoku'office’, ...)
b. X o0 onegai shimasu. please give me the' XX=bang ‘number’, ...)

The idea is quite widespread in the EBMT literatureluding Kaji et al.’s
(1992) “pseudo-sentences”, Langé et al.’s (199Kgl&ton sentences” and a number
of others’ The examples are usually generalized by mergimilai cases, though
authors differ as to whether this can be done @aoiomatically, or manually.
Certainly, if the idea was applied to TMSs, TMs Idobe much reduced in size,
though access would presumably have to be morastimaited.

3.3 Matching techniques

Accessing the TM or example-base involves “matchitg given translation unit
against the cases already stored. Early implemensabf TMSs could handle only
exact matches, although alphanumeric “replacealale#i (4) were allowed.

(4) a. This is shown as A in the diagram.
b. This is shown as B in the diagram

Bowker introduces the distinction between an “€kazitch and a “full” match.

An exact match is 100 percent identical to the sagrthat the translator is currently translating,
both linguistically and in terms of formatting. This means that the two strings must be
identical in every way, including spelling, pundioa, inflection, numbers, and even formatting
(e.g., italics, bold). (Bowker, 2002:96f)

Thus (5b) would not be retrieved as an exact mitckba) because of the difference
in formatting.

(5) a. Click on OK
b. Click onOK.

A “full match” on the other hand,

... occurs when a new source segment differs frotor@d TM unit only in terms of so-called
variable elements, which are sometimes referrecado“placeables” or “named entities”.
Variable elements include numbers, dates, timesenpaies, measurements, and sometimes
proper namesil{id., p. 98)

Bowker’'s “placeables” have been termed “transworlly” Gaussier et al.
(1992), while Macklovitch and Russell (2000) cdlemn “non-translatables”. The
notion of “named entities” is found in InformatidRetrieval. As the latter authors
point out, they are treated in translation in deattransparent manner, either not
translated at all, or subject to specific convemijoand in any case, independent of
context. For a TMS their impact is twofold. On anple level, we want to have
matchers that “ignore” them, so that (4a,b) abonee edfectively “exact matches”.
Additionally, in a more sophisticated TMS (and iBBMET), they are important
building blocks for suggesting automatically a hkéranslation of the given text.
Consider (6a) as a text to be translated, whictchest with (6b), with the differences
highlighted, and its associated translation (6¢)(@b) there are two transwords the
“translation” of which can be readily identified {6c), but you have to know the
target language to know which word to change in (6caccommodate the lexical
differencelarge vs.small

° Nomiyama (1992), Almuallim et al. (1994), Akibaat (1995), Collins and Cunningham (1995), Jain
et al. (1995), Matsumoto and Kitamura (1995), Wakenand Takeda (1998), Carl (1999) — see Somers
(1999:139ff).



(6) a. The large paper tray holds up to 400 sheets3giaber.
b. The_smalpaper tray holds up to 3Gbeets of Adaper.
c. Die kleine Papierkassette fasst bis zu 300 Bla#t4r-ormat

Some TMSs claim to use sophisticated matching #lgos (e.g. Trados’s
claimed use of “neural networks”) and Heyn stales t

Modern computer science does, however, offer soorable solutions to similarity problems
using fuzzy processing. These approaches incluaagh of neural networks and sparsely coded
matrices. Whereas the first generation of the Tsaanslation memory system, for example,
was based on a classical binary approach, andu{stigally motivated) substring operations on
classical database indices, the current generagimploys sparsely coded matrices. The
advantages are obvious: phenomena like misspellingscomplicated syntactic deviations are
now manageable and access time has been reducéitaigly. (Heyn, 1998:127)

However, all the evidence so far is that matchimg TIMSs is essentially a
straightforward implementation of a character-basedit distance”, that is, the
widely used measure of string similarity which ctsuthe minimum number of
substitutions, insertions and deletions neededhange one string into anoth@r.
Example (1) above illustrates the problem with #pgroach, as does (7), where (7b)
differs from (7a) by only four letters, comparechiae for (7c)**

(7) a. The wild child is destroying his new toy.
b. The wild chief is destroying his new tool.
c. The wild children are destroying their new toy.

Consider also examples like the sentences in §8 match for (8a), the edit distance
algorithm will prefer (8c) over (8b) because of @dditional words. Similarly, (8b)
and (8d) should be considered more similar thah #8d (8c), because they contain
more text in common; but the simple edit distanasasures only differences, not
similarities’?

(8) a. Select ‘Symbol’ in the Insert menu.
b. Select ‘Symbol’ in the Insert menu to enter arelster from the symbol
set.
c. Select ‘Paste’ in the Edit menu.
d. Select ‘Paste’ in the Edit menu to enter someftem the clipboard.

Proposals for a search mechanism for TMSs thasteyetactic and/or semantic
information into account have been made by vareuthors. Dennett (1995) makes
two proposals for TMSs: the first takes into coesation the relative significance of
the words that have been changed, possibly onabis bf statistical data; the second
identifies syntactically significant portions ofethsegment. Cranias et al. (1997)
propose a scheme for both TMSs and EBMT that mggesial use of function words
as well as POS tags, and looking at lemmas ratter strings. Planas and Furuse
(1999) suggest a flexible multi-layer matching sobkeas indicated by their structure
(seen in Figure 2, above). Macklovitch and Rug&£lD0) and Rapp (2002) similarly
suggest taking inflection and syntactic categoty account.

19 So-called “fuzzy match” scores may take into aotoather superficial differences such as
formatting, or the source of the example, but itridikely that anylinguistic sophistication is involved,
despite the manufacturers’ claims.

" These examples are from Planas and Furuse (1999:33

12 These examples are from Somers (1999:129).



Interestingly, in EBMT it was always assumed thaiteching would be on a
more sophisticated basis. The earliest proposajs Kagao 1984; Sumita et al. 1990;
Sumita and lida 1991) involved a thesaurus to nreasg@mantic proximity of
structures, as illustrated by Nagao’s original egenwhere (9a,b) might be stored as
examples (along with their Japanese translationshasvn — the key being the
different choice otaberuvs. okasufor ‘eat’). If we wish to translate (9c), then J9&a
chosen as the model because of the better mataledminanandhe, andvegetables
andpotatoes Conversely, (9b) is a better model for transta(@d).

(9) a. A man eats vegetablé$ito wa yasai o taberu
b. Acid eats metal. San wa kinzoku o okasu
Cc. He eats potatoes.
d. Sulphuric acid eats iron.

Other EBMT developers (like Cranias et al. 1997eady mentioned) have
proposed using POS tags or treating function words particular way (Furuse and
lida 1994; Veale and Way 1997). In the multi-engiangloss system, the matching
process successively “relaxes” its requirements| ammatch is found (Nirenburg et
al. 1993): the process begins by looking for exaatches, then allows some deletions
or insertions, then word-order differences, therrphological variants, and finally
POS-tag differences, each relaxation incurringn@neiasing penalty.

Chatterjee (2001) proposes an evaluation schemeeveheumber of different
features, differentially weighted, combine to gevescore which reflects similarity at
various levels: lexical, morphological, syntacgemantic, pragmatic. The strength of
EBMT, especially for dissimilar language pairsjnisusing examples with a similar
meaning, rather than a similar structure, so thatsemantic and pragmatic features,
which can still be captured by simple morphosyntatdéatures (e.g. whether the
subject of the verb is animate) are weighted hgavil

Earlier proposals for EBMT, and proposals where HBBlintegrated within a
more traditional approach to MT, assumed that tkemgples would be stored as
structured objects, so the process involves aratioee complex tree-matching (e.g.
Maruyama and Watanabe 1992; Matsumoto et al., 119@8)gh there is generally not
much discussion of how to do this (cf. Maruyama #vatanabe 1992; Al-Adhaileh
and Tang 1998), and there is certainly a consideramputational cost involved, so
this is probably a step too far for TMSs.

3.4 How many matches?

The final issue to be discussed in this sectiahesquestion of how the matches are
presented to the user. The standard method in TisI$s present the single best
match, with an indication of its “score” and thespibility of other matches being

available with a lesser score, or else to showa iscrolling window, a range of

matches, ordered once again by score. Bowker (20@2:gives a nice example,

partly reproduced here, in which the source segifi€}&) matches best against (10b),
then (10c) and so on. The exactly matching partshef retrieved examples are
highlighted.

(10) a. The operation was interrupted because the &k mdden.
b. The operation was interrupted becauseQtrec key wagressed.
c. Thespecified method failed because the iididden
d. The operation was interruptég theapplication.
e. Therequested operatiadannot be completed becausedisk is full.




The examples in (10) show very nicely a featuré Wwauld be very desirable in
TMSs, but so far has only been a promise, withrastable exception. The translation
of (10a) could actually be achieved by selectiregdppropriate parts of two examples
retrieved from the TM: the first part of (10b) lied to the second part of (10c). This is
the idea of “sub-segment matches”, which, as BowRk602:103) points out, “falls
partway between fuzzy and term matching”. The ndiffierence is that the segments
identified in this manner would not have the statiterms; indeed, the sub-segments
would be identified on a case-by-case basis, andadeven have to correspond to
complete phrases, as illustrated in (10b), whegestib-segment ends in the middle of
the noun phrase.

Simard and Langlais (2001) explicitly suggest thé idea be incorporated into
TMSs, referring to the EBMT literature where it Heeen around for a while. Simard
(2003) explains the scheme in more detail. Niregbat al. (1993) referred to
“substring” matching, Somers et al. (1994) prefértbe term “fragments”, while
Collins (1998) talked of “chunks”. Figure 3 illuates the idea.

Sour ce sentence:

there is a danger of aval anche above 2000m

Mat chi ng fragnents

danger of N < > above, danger of, of N < > above,
above CRD m there is a, aval anche < > above,
there is, is a, danger of aval anche,

aval anche above CRD m aval anche above,

of aval anche, there is < > g,

is <>a, there is a < > danger < > of,

there is < > danger < > of, there is a < > danger
a < > danger, there is < > danger

Figure 3. Fragments extracted for the inplére is a danger of avalanche above 2000m
The individual words are POS-tagged (not shown a¢he matcher can also match tags
only, and can skip unmatched words, showr as. Nis noun, CRD is cardinal number.
Adapted from Somers et al. (1994).

Simard and Langlais suggest concentrating on “istgually motivated” sub-
sequences, though this implies that the matchert rmedude some “linguistic
knowledge”. Merkel et al. (1994) describe a systemich extracts “recurrent
segments” from a corpus, storing only the longestsiple segments where there is
overlap.

One commercial TMS does offer the possibility ofeambling a translation
from fragments: Déja Vu, in its latest version, ®éfu X, talks about EBMT
technology when describing the functionality ofith&/stem. In the user’s manual
they claim:

We use the terrexample-based machine translatitmdescribe Déja Vu X’s unique ability to

self-repair fuzzy matches from the translation mgmioy deleting the incorrect part of the

sentence and replacing it with the correct one.vigled that Déja Vu X has sufficient

terminology databases, it is able to do this thiodlge close association of the memory
matching and assemble processes. [emphasis otiginal

Déja Vu names this facility “assemble from portibnghe facility makes it
possible to convert fuzzy matches into exact mateutomatically.

Figure 4 shows the system assembling the translétib) (marked with a blue
line in the figure) from the three portions indiedt(marked with green lines in the
figure).



(11) Ensure that the phone is switchedam_in servicdefore proceeding to
step 2
Asegurese de que el teléfono esté encendido yeiofamiento antes de
continuar con el paso 2.

Deja Yu X - [E:\Gabriela\MemoriasdeTraduccioniitriliMy Projectsiphone. dvprj] - [ATfno. txt]

E‘ File Edit Insert Wew Translation Project Lexicon Users Tools Window Help =] xj
DE oo | A BREX. &0 A% 4 = 2] G006 9% @+ 8.
| |AI\ Rows j ‘ESpanish

English (United States) | Spanish | :

[E] Thno.txt
en funcionamiento Bl Thhoz.bxt

b N service

before proceeding to step 2 m—nites de continuar con el paso 2
ensure that the phone is switched on —oseglrese de que el teléfono esté enchufado

ensure that the phone is switched on and in service before  ee—zcegirese de que el BIEfono esté enchufado v en
proceeding to step 2 funcionamiento antes de continuar con el paso 2

ensure that the phone is switched on and in service = aseglrese de que el teléfono esté enchufado

[E) \Tfnoz st | (2] \TFno.tet

Afs | ASr APr | ASd AC_h Fo[10-0/17 [1)5 | Last modified by: gfernan | 14/12/2003 08:56:37 p.m.

Figure 4. Déja Vu’'s “Assemble from portions” fatyli

However, it must be reported that our experiéhtiee conditions have to be very
favourable for this facility to work. For examplihe portions have to be roughly
equal in length and “importance”: we were unablgebit to offer a translation from
portions of (12)marked with an incomplete green line in the figurehere the first
portion represents too high a percentage of tte seintence. Also, it appears that all
the portions have to be in the TM, and have to mat@ctly (everand=y must be in
the TM) before it will work satisfactorily.

(12) Ensure that the phone is switched on and in service

We should not be too harsh on Déja Vu, becausalféctubsegment matching
and reassembly represents the most difficult teathrmproblem for EBMT. Notice
once again the difference between TMSs and EBME& TMS it is up to the user to
decide what to do with the matches, whereas in EBRE system must operate
automatically. Consider again (10b,c), this timehwiheir associated translations,
reproduced here as (13).

(13) a. The operation was interrupted becauseCtinec key wagpressed.
L’opération a été interrompue car la touché Ctr&@&té enfoncée.
b. Thespecified method failed because the ildidden

13 We are grateful to Luis Cerezo Ceballos for hiskweith Déja Vu.



La méthode spécifiée a échoué car le fichier esigué

The user (or system) of course has to know Fremdte tsure which parts of the
translations correspond to the underlined segmemd,to know how to fit them
together. In EBMT this is known as “recombinatiomihd involves the “boundary
friction” problem. Assuming one can correctly idénthe target-language fragments
associated with the source-language fragments tf@ads not necessarily trivial), it
may not be the case that they can be simply “gltegéther. This is better illustrated
with a language like German. Suppose for example exgact the translation
associated witthe handsome bdyom (14a): it is not equally reusable in eithéthe
sentences in (14b,c), since in German the fornmefdeterminer, adjective and noun
can all carry inflections to indicate grammaticase (14d,e).

(14) a. The handsome b@ntered the room.
Der schéne Jungkam ins Zimmer
b. The handsome boy ate his breakfast.
c. | saw the handsome boy.
d. Der schone Jungass seinen Frihstick
e. Ich sah den schdénen Jungen

4 Where EBMT and TMSs differ

So far we have looked at a range of issues thanare or less common to TMSs and
EBMT. There are important differences however, nyastemming from the fact that
a TMS is a translator’'s aid, where the user hasmhben responsibility for making
decisions, whereas EBMT is a way of doing transtatiutomatically.

The main difference then lies in the fact that aSMas essentially just the
single step of matching examples, while EBMT mumntdo sanething with the
matches found. As Ahrenberg and Merkel (1996) state

The ddifference between a translation memory agppat tool for the translator and a full-
feldged example-based system is thus basicalljfereince in who has the prime responsibility
for drawing analogies and structur[ing] the target during translation.

What EBMT does consists of two steps, often reteme as alignment and
recombination.

4.1 Automatic alignment of matches

We have already referred to thBgnmentproblem, although not by name as stfth.
This is the task of knowing which parts of the (@ match are relevant for the
translation. In particular, examples (6) and (18yewsed to illustrate the point.

In most EBMT systems, the solution lies in the itz examples are stored. In
early systems, as we have already noted, exampdestared as linked structured
representations, as exemplified in Figure 1. Anotggoroach, seen for example in
Somers et al. (1994), is to extract common elemieots multiple matches. Looking
again at Figure 2, it might be that the phrdse is a dangeoccurs in numbers of
slightly different examples, but we can try to extrthe target-language equivalent of
this phrase because it will (presumably) recurhia translations paired with the
retrieved examples. This is one of the basic idessl in efforts to extract bilingual

4 Not to be confused with the process, also caliigtiment”, of converting a parallel text into a TM
There are of course some common aspects to thesamilarly named processes.



lexical alignments from parallel texts (cf. Véron2000). The techniques often
involve statistical measures of co-occurrence, ghaeliance on such measures alone
is not generally enough, and many authors try &bsincorporate some linguistic
information into the process, making use of a bilial dictionary (e.g. Kaji et al.
1992; Matsumoto et al. 1993) or existing MT lexicas in the cases where EBMT
has been incorporated into an existing rule-baseutacture (e.g. Sumita et al. 1990;
Frederking et al. 1994).

EBMT however goes beyond this kind of lexical afiggnt, since the examples
retrieved are sources not just of lexical equivedemformation, but also serve as
modelsfor the structure of the target text.

4.2 Recombination

This is where the second step comes in: the tdagetiage fragments suggested by
the examples then have to be reassemblece@ymbinedto form the target text.
Where EBMT is combined with more traditional methothe system might include a
target-language grammar which could iron out arffrcdities in creating the target
text. More recently, such grammars have been dérargomatically from parallel
corpora, as is the case with Stochastic Inversramgduction Grammars (Wu 2000b).
Simard and Langlais (2001) report experiments with formalism. Other researchers
discuss the problem and in general seem to agrate sttme form of grammar
formalism is needed (e.g. Carl 2001; Way 2001).

4.3 Generalized examples

A major trend in EBMT is to try to form generalnsdation (or “transfer”) rules from

the examples. We have already seen this illustrated?2) above, where the
generalized examples are presumably constructeduatign but a number of

researchers have proposed doing this automatioallthe basis of “minimal pairs”,

i.e. pairs of sentences that contrast in a minimvaly, and from which some
generalization can be inferred. Consider the Ehglisirkish sentence pairs in (15)
(from Cicekli and Glvenir 1996; Guvenir and Cicekli98) or the English—Spanish
pairs in (16) (from McTait et al. 1999; McTait 2001

(15) a. Itook a ticket from Mary> Mary’den bir bilet aldim
b. 1 took a pen from Mary> Mary’den bir kalem aldim
(16) a. The Commission gave the planpLa Comision abandond el plan
b. Our Government gave all laws #pNuestro Govierno abandono
todas las leyes

From the sentence pairs can be identified the cametements, which are supposed
to be mutual translations (17). This generalizattam be stored as a translation
“template”.

(17) a.ltook a ... from Mary— Mary’den bir... aldim
b. ... gave ... up~» abandoné
The complementary elements in the matched senteacelse supposed to correspond
as shown in (18).

(18) a. ticket bilet; pen< kalem
b. The Commission ... the plar La Comision... el plan
Our Government ... all laws> Nuestro Govierno.. todaslas leyes

In the case of (18b), there is more work to be deimee (notwithstanding knowledge
of Spanish or recognition of cognates), we haveestablish how the remaining



elements match up: this can be done by lookingiréihér examples which isolate the
words in question.

Of course much of this work could be simplified hwihe help of an on-line
dictionary, assuming we had one. But what is adriegt to researchers is the extent to
which it can be automated. To exemplify this, cdasithe examples in (19), in a
language probably unfamiliar to most readers.

(19) a. Dia nak prgi ke kedai beli roti.
She is going to go to the shops to buy bread.
b. Dia pergi ke pasar nak bli baju.
She went to the market to buy a shirt.
c. Mereka prgi ke kampung nakdhi kereta.
They went to the village to buy a car.

It is not difficult to identify the probable wordapings and from the examples to
construct the correct translations of sentences tlilose in (20), and we invite the
reader to try it as an exerciSan doing so it should be noted how much generic
(common-sense) knowledge about how languages werlasvhumans bring to this
task, which may have to be simulated in an otherpigely automatic system.

(20) a. She went to the village to buy bread.
b. They are going to the market.

5 TMSs would be better if they were more like EBMT

Our purpose in this paper has been to point out sawe of the ideas developed in
connection with EBMT could be introduced into thevelopment of TMSs. In this
final section we attempt to summarize the main psags.

 If they could identify what in the target part beEtmatch has to be changed.

If we want to be able to match similar sentencesh s those differing only in the form of their
words, we need linguistic analysis. We do not neel®ep analysis that would take a long time
to process, but just a “stemming” and a “taggingie ahat would give a light but crucial
analysis (Planas 1999:9).

[T]he most promising strategy for the next generatif TM systems will be to employ various
partial parsing or “chunking” techniques. (Mackka¥i, 2000)

» If they could make suggestions about what in thgetapart of the match has to
be changed to.

 If they could construct target texts from matchedyments.

 If they could take similar examples and make gdrizatgons about them.

TM and EBMT can be seen to lie at opposite ends gfectrum in memory-based translation.
On the one hand, TM requires few linguistic[ ] nes@s but cannot combine fragments from
different T[ranslation] U[nit]s, and on the otheartd, EBMT can combine example fragments,
but does so by relying on ... knowledge-intensivdsgo@cTait et al. 1999)

5 The language is Malay. The correct translatioesDéa pergi k¢ kampungnak beli roti ; Méreka nak
pergi ké pasar
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